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Introduction

1.1

Introduction to IMiN Communicator
IMiN Communicator is corporate grade Instant Messaging and Presence Awareness Software.
Communicator's presence awareness features lets you see who is currently online before you send a
message. Users can not only send messages to one another using Communicator, they can also send
and receive email, SMS, and pager messages.
Communicator is fully customizable, allowing individual users to create their own one-touch
responses and other functions. This allows you to deal with many messages with a single keystroke.
You can create a Favorite list for people who you communicate with frequently and create customized
groups that you can keep private, or share with other IMiN users.
Communicator does not tie you to a single location. It can be setup on your home and work computer
or your laptop. Your customized settings and Archived messages are stored on a central server to
provide you with the same "look and feel" wherever you are.
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Communicator Interface Overview
The following is a general overview of the Communicator interface.

Figure 1A
a. User Tree – The User Tree lists all of the users you can send messages to.
For more information, see Understanding User Tree.
b. Recipient Window – Shows where the message/reply will be sent.
c. Outgoing Message Window – Messages/replies are typed here.
d. Sender Window – Shows who sent the message. Also displays the location and application from
which the message was sent.
e. Incoming Message Window – Messages received are displayed here.
f. Fast Keys – Fast Keys are "one-touch" response keys that eliminate the need to type a reply.
For more information, see Replying To A Message.
g. Send Button – Sends the message/reply.
h. Clear Button – Clears the contents of the Recipient, Sender, Incoming and Outgoing Message
© 2006 - R.B.Zack & Associates, Inc.
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windows.
i. History Button – The History allows you to view and print any messages you sent or received.
For more information, see History.
j. Find Users Button – The Find Users feature allows you to search for any user in any Zone.
For more information, see Find Users.
k. Tools Button – The Tools button accesses the Communicator Preferences.
l. AutoReply Button – The AutoReply feature allows you to automatically send a predetermined
reply to anyone who sends you a message
For more information, see AutoReply.
m. Close Button – Minimizes the Communicator interface to the system tray.
n. Status Area – Displays status messages when certain activities take place. For example, when a
message is successfully sent, the status message will say "Delivery Successful".
o. Character Counter – Displays the number of characters in the Outgoing Message window.
p. Unread Message Counter – Displays the number of unread messages.
q. AutoReply On/Off Indicator – Indicates whether AutoReply is on or off.
r. Time – Displays the time.
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Communicator works together with another program called EBS Proxy. The Proxy logs you into the
IMiN network and provides you with a secure connection. Communicator is the program you use to
actually communicate with other users.
To start Communicator:
1. Go to Start > All Programs > IMiN > Communicator > Communicator. See figure 2a.

Figure 2a
2. The Proxy will start automatically and bring up the EBS Log On screen. Enter the Login name and
Password provided by your network administrator. Select a Location. Click "OK". See figure 2b.

Figure 2b
Checking "Remember Password" will eliminate the need to enter your password each time you log in.
Checking "Login Automatically" will allow you to bypass the EBS Log On screen altogether.
3. When the Proxy connects, a satellite dish icon with a green check mark over it will appear in the
system tray.
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If the Proxy cannot connect, the satellite dish icon will appear with a red "x" over it.
Contact your network administrator.

4. Once the Proxy connects, Communicator will start up. An hourglass icon will spin in the system tray
while Communicator is attempting to connect. When Communicator connects, a blue dialog bubble
icon will appear replacing the Proxy icon.

If Communicator cannot connect, the hourglass will continue to spin over the dialog bubble icon. If
this persists, contact your network administrator.

Auto Start
Communicator can be configured to start automatically whenever the computer is turned on or
rebooted. To do this:
1. Check "Login Automatically" on the EBS Log On screen. This will automatically check the
"Remember Password" box. See figure 2c.

Figure 2c
2. In Communicator, go to Tools > General. In the General section, check the Auto Start box. See
figure 2d.

Figure 2d
The next time your computer is re-started, Communicator will Auto Start.
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Displaying/Hiding The Communicator Window
Once started, Communicator continues to run in the background even when the Communicator
window is not displayed on the screen. This allows you to work normally without having to keep the
program open all the time.
To indicate that Communicator is running, a blue icon is continuously displayed in the system tray in
the bottom right-hand corner of the computer screen.

To display the Communicator window:
1. Click once on the Communicator icon in the system tray. Or…
2. Ctrl + Shift + Up Arrow
This keyboard shortcut can be customized.
See Communicator Preferences > General > One Touch Maximize
To hide the Communicator window:
1. Click on the Communicator icon in the system tray again. Or…
2. Click the "Close" button on the tool bar. Or…
3. Click "Minimize" or "Close" on the Communicator window. Or…
4. File > Hide. Or…
4. ESC key.
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Understanding the User Tree
The User Tree lists all the users and entities that you can send messages to.
Favorites, My Zone, My Site and Groups
The User Tree has four main areas; "Favorites", "My Zone", "My Site" and "Groups".
See figure 4a.

Figure 4a
1. Favorites
Favorites is an area where you can create a custom list of the recipients you send messages to most
often. See figure 4b.

Figure 4b
For more information, see Add To Favorites.
2. My Zone
A zone is a list of users. My Zone is simply a list of all the users in your particular zone.
See figure 4c.
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Figure 4c
The users included in My Zone can vary depending on how your network administrator organizes your
IMiN network. Typically, My Zone would include all of the users within your company. Other zones
appearing in the User Tree could be, for example, other organizations that your company needs to
communicate with.
My Zone could also represent all the users in your department. In this case, the other zones could be
other departments within your company.
3. My Site
My Site contains every zone including your zone. See figure 4d.

Figure 4d
4. Groups
A group is a customized list of recipients. See figure 4e.

Figure 4e
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You can create your own groups which can only be seen by you (Private Groups). Your network
administrator can create groups which can be seen by everyone (Public Groups).
For more information, see Groups
Locations and Applications
You can have more than one location where you can send and receive messages. In most cases,
your primary location will be "Desk". However, if you sometimes work from home, you could also
have "Home" listed as a location.
In this example, Tim Martin has four locations; "ConfRoom", "Desk", "Home" and "Laptop".
See figure 4f.

Figure 4f
Communicator is the primary application used to send and receive messages. Usually, messages are
sent from one Communicator user to another. However, Communicator can also be used to send
messages to email and to cell phones and pagers.
In this example, Tim Martin has "Communicator" listed as an application at all four locations.
However, at his "Desk" location, he also has "Email" and "SMSPager". See figure 4f.
Note: Email and SMSPager are optional features. Check with your network administrator to see
whether they are available at your organization.

Expand/Collapse View
The view of the User Tree can be expanded or collapsed.
To expand the view, right click on the area (Favorites, My Zone, My Sites or Groups) or user you wish
to expand and select "Expand all Children". See figure 4g.
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Figure 4g
To collapse the view, right click on the area or user you wish to collapse and select "Collapse all
Children". See figure 4h.

Figure 4h
Note: Clicking "+" or "-" also expands or collapses the view.
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Sending A Message
There are three steps involved in sending a message to another user:
1. Choose where the message will be sent
There are two ways to choose where the message will be sent:
a. Recipient Window
Begin typing the name of the person into the Recipient Window. The window will display a list of
available recipients matching the first two letters of the name you typed in.
The recipient may be available at a location other than the "Desk" (i.e. "Home") and/or on an
application other than "Communicator" (i.e. "Email", "SMSPager"). A message may be sent to any of
the users\locations\applications listed. See figure 5a.

Figure 5a
Note: Selecting "Search Site" from the list will allow searches for recipients in other zones.
For more information, see Find Users.
b. User Tree
Select the recipient from the User Tree by clicking on the desired user\location\application. More than
one recipient may be selected. The message will be sent to all selected recipients if available.
The User Tree uses icons to identify the availability of the recipient.

: Communicator is online. Message can be sent.
: Communicator is in AutoReply mode. Message can be sent.
: Communicator is in Not at Desk mode. Message can be sent.
: Communicator is offline. Message cannot be sent.
Note: Messages can be sent to Email and SMSPager at any time. The recipient is always considered
available on both of these applications.
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Example 1: Selecting a recipient from the User Tree
Selecting the recipient "Tim Martin" will send a message to each of the locations and applications
where Tim Martin is available. In this case, the locations\applications are "Home\Communicator" and
"Laptop\Communicator". The selection is indicated in green next to the name. Available
locations\applications listed below the selection are indicated in purple. See figure 5b.

Figure 5b
Note: Selecting a recipient will not automatically send a message to their Email or SMSPager. Each
of these must be specifically selected.
Example 2: Selecting a specific application from the User Tree
Selecting the application "Communicator" at the location "Laptop" for "Tim Martin" will only send the
message to Tim Martin at his laptop. Again, the selection is indicated in green. "Laptop" is indicated in
solid blue. This means that every available application listed below "Laptop" has been selected. The
half blue indicator next to "Tim Martin" means that only some of the available applications listed
below "Tim Martin" have been selected. See figure 5c.

Figure 5c
A message can be sent to a group of recipients. For example, selecting My Zone will send a message
© 2006 - R.B.Zack & Associates, Inc.
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to all available recipients in your zone.
Messages can also be sent to Favorites, groups listed under Groups and zones listed under My Site.
Messages may be sent to My Site if administrative permission is granted.
Multiple zones and groups may be selected.

2. Type the message
Type the message in the outgoing message window. If the cursor is not already in the outgoing
message window, click once inside the window.

Figure 5d
Clickable hyperlinks and email addresses can be included in the message. Text can be colored,
formatted and edited by right clicking inside the outgoing message window then selecting the desired
option from the panel.
3. Send the message
Click "Send" to send the message. Alt+S or Ctrl+Enter will also send the message. By default,
Communicator will close on send.

© 2006 - R.B.Zack & Associates, Inc.
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Receiving A Message
When a message is received, Communicator notifies you with a pop-up window and an audible alert
(both are default settings which can be changed). The Communicator icon in the system tray toggles
back and forth between a single and double icon.

The message received is displayed on the screen in the incoming message window. The name of the
sender and the location/application from which the message was sent are shown in the sender
window just above. See figure 6a.

Figure 6a
You can change the way Communicator notifies you when a message is received.
See Communicator Preferences > General > Message Notifications and
Communicator Preferences > Audio

Receiving Multiple Messages
There will be times when you receive more than one message within a short duration. When that
happens, all subsequent messages stack up behind the first message in the order in which they are
received.
Communicator notifies you with an audible alert each time a subsequent message is received. This
alert sound will be different from the first message received alert.
The message counter in the status bar shows the number of unread messages. See figure 6b.

Figure 6b
The first message will remain on the screen until you either reply to it or scroll to the next message.
After you respond to the first message, the next message in line will be displayed. When the last
message is either read or responded to, the unread message counter will read "0".
Note: A message is considered "read" by Communicator when you (a) reply to it (b) scroll to the next
message or (c) close the Communicator window.
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Replying To A Message
There are two ways you can reply to a message:
1. Type the reply
When a message is received, you can begin typing your reply immediately. The cursor will already be
in the outgoing message window and the sender's name will be listed as the recipient. Click "Send"
when finished typing. The Communicator screen will close automatically.
2. Fast Keys
Fast Keys are "one-touch" response keys that eliminate the need to type a reply. The default Fast Key
message set is shown below in figure 7a.

Figure 7a
You can either click the desired Fast Key or press the corresponding function key. There is no need to
click the "Send" button. The reply is sent and the Communicator screen closes all in one action.
There are two Fast Key message sets; the "Primary Set", which is the one displayed, and the "Control
Set". The Control Set can be displayed by holding down the control key. To use any of the Fast Keys
on the Control Set, hold down the control key while selecting the desired Fast Key.
Note: This example uses a Communicator skin with 12 Fast Keys. The number of Fast Keys
displayed depends on the skin selected. Skins with 18 and 24 Fast Keys are also available.
Each message set contains 12 Fast Keys all of which can be customized.
See Communicator Preferences > Fast Keys

© 2006 - R.B.Zack & Associates, Inc.

IMiN Communicator

2.7

17

Browsing Messages
You can scroll through your incoming messages by using the right/left browse buttons located to the
right of the sender window. See figure 8a.

Figure 8a
Clicking the right arrow button advances to the next message. Clicking the left arrow moves back to
the previous message.
The keyboard shortcuts are Alt + Right Arrow and Alt + Left Arrow.
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AutoReply
The AutoReply feature allows you to automatically send a predetermined reply to anyone who sends
you a message.
For example, if you're in a meeting and cannot respond to incoming messages, you can select "I am
in a meeting" as your AutoReply. Anyone sending you a message will automatically receive that
message back.
To turn on AutoReply:
1. Click on the AutoReply button located on the tool bar of the Communicator window. See figure 9a.

Figure 9a
2. The AutoReply window will appear. See figure 9b.

Figure 9b
3. Select an AutoReply from the drop-down menu. See figure 9c.

Figure 9c
…or add a new AutoReply. Click "OK". See figure 9d.
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Figure 9d
4. The Communicator screen will close automatically. AutoReply is now turned on.
When AutoReply is turned on, the button on the tool bar will appear indented (Figure 9e). Your
Communicator icon will appear with an arrow over the top of it (Figure 9f).

Figure 9e

Figure 9f
5. When someone sends you a message, they will receive your AutoReply message. See figure 9g.

Figure 9g
They will also receive an AutoReply Notification. If the sender clicks "Yes" to the notification, an
Online Notification Watch will be placed on you. They will automatically be informed when you turn
off AutoReply. See figure 9h.

Figure 9h
Note: Messages you receive while AutoReply is turned on are treated like any other messages and
are available to read whenever you want.
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To turn off AutoReply
Open the Communicator screen and click the AutoReply button again.
The feature can also be turned off by right clicking on the Communicator icon and then left clicking
the AutoReply option in the panel. See figure 9i.

Figure 9i

© 2006 - R.B.Zack & Associates, Inc.
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Find Users
The Find Users feature allows you to search for any user in any zone.
To find a user:
1. Click the Find Users button located on the tool bar of the Communicator window. See figure 10a.

Figure 10a
2. The User Search window will appear. Begin typing the user's name in the search window. The
window below will list any matches. Select the desired user and click "OK". See figure 10b.

Figure 10b
Note: Searches may be done on any part of the user's name. Select the search option from the pulldown menu next to the "Search" button. Options include "Starts with", "Contains", "Ends with" and
"Exact".
3. The selected user is automatically added to Favorites. If the user is online, their name is placed in
the recipient window. If the user is not online, you will receive a message saying that the user has
been added to Favorites but is currently offline and cannot be selected now. See figure 10c.

Figure 10c

© 2006 - R.B.Zack & Associates, Inc.
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History
The History allows you to view and print any messages you sent or received.

To open the History window:
Click on the History button located on the tool bar of the Communicator window. See figure 11a.

Figure 11a
The History Window
The History window contains six columns. See figure 11b.

Figure 11b
a. S/R (Sent/Received) – Blue left arrow icon indicates a "sent" message. Red right arrow indicates a
"received" message.
b. Loc. (Location) – The location you are logged in at when you sent or received the message.
c. Time (Date) – The time/date that the message was sent or received.
d. From – The sender.
e. To – The recipient.
f. Message – Message content.
Each column can be sorted in ascending or descending order by clicking on the column heading. For
example, clicking on the Time (Date) heading will sort the messages so that the oldest messages are
displayed first and the newest last. Clicking it again will display the newest first and oldest last.

© 2006 - R.B.Zack & Associates, Inc.
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Note: The History title bar displays the number of messages in the message list.

The Message History Filters
There are five message filters that allow you to determine which messages appear in the list.
See figure 11c.

Figure 11c
a. Location - The location of the user. Messages can be viewed either by "This location" or "All
locations". "This location" will list messages sent/received at the user's present location. "All locations"
will list messages from any location where the user has had Communicator running.
b. Direction – The user can view "Sent" messages only, "Received" messages only or both "Sent
and Received" messages.
c. Time – The user can specify the time frame of the messages to be displayed. Choices include
"Today", "Yesterday", "This Week", "Last Week", "This Month", "Last Month" or "Anytime".
d. Keyword - Messages can be listed based upon a keyword search of the message content.
e. Search Button – Click the Search Button after filter selections are made.
Creating a Custom Message View
To create a custom message view, select the desired search option from each of the three pull-down
menus. Enter a keyword if needed.
For example, to view all messages sent last week containing the word "order":
1. Select "All locations" under Location, "Sent" under Direction, "Last Week" under Time and enter
"order" in the Keyword window.
2. Click the Search button.
3. All messages matching the selected criteria – if found – will now appear in the list.
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Note: When the History window is closed, the view will return to the default setting of
Location > "This location", Direction > "Sent and Received", Time > "This Week" and
Keyword = blank.

Printing
The History has a print option that allows you to print individual messages, selected messages or all
messages. See figure 11d.
To print individual or selected messages, highlight the message(s) to be printed then go to File >
"Print Selection".
To print all messages within the active view, go to File > "Print All".

Figure 11d
Conversation View
The Conversation View displays the entire conversation associated with any message. Select a
message from the list then double-click on it to display the conversation. See figure 11e.
The "Next" and "Previous" buttons bring up the next/previous message conversation.
The "Print" button allows the conversation to be printed.
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Figure 11e
Note: The Conversation View title bar displays the number of messages in the conversation.
The Delivery Report shows whether the message delivery was successful.
Click the "Delivery Report" button to display the report. See figure 11f.

Figure 11f
The Delivery Report is most useful when sending a message to a group. The report will tell you who
received the message and who did not.
Deleting Messages
Messages cannot be deleted.
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Not At Desk Mode
The Not At Desk mode is used to automatically notify others whenever you are logged into
Communicator but have been away from your computer for a period of time. By default, this period is
15 minutes.
When Not At Desk mode is active, your Communicator icon will appear with a white note over it.

When someone sends you a message, they will receive your Not At Desk message. See figure 12a.

Figure 12a
They will also receive a Not At Desk Notification. If the sender clicks "Yes" to the notification, an
Online Notification Watch will be placed on you. They will automatically be informed when you return
to your desk. See figure 12b.

Figure 12b
Not At Desk mode is de-activated when you return to your computer and either move the mouse or
touch the keyboard. Your Communicator icon will now appear without the white note over it.
Note: Messages you receive while in Not At Desk mode are treated like any other messages and are
available to read whenever you want.
The Not At Desk mode message and inactivity period can both be customized. Not At Desk mode can
also be turned off altogether.
See Communicator Preferences > General > Not at Desk mode

© 2006 - R.B.Zack & Associates, Inc.
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Online Notification Watch
Online Notification Watch lets you know when another user comes back online.
To add an Online Notification Watch to a user:
1. Locate the user in the User Tree. The user can be in "Not At Desk" mode, "AutoReply" mode or
even completely logged off. Right click on the user's name.
2. Select "Add Online Notification Watch" then left click. See figure 13a.

Figure 13a
3. When the user comes back online, a notification will appear on your computer desktop. An audible
alert will sound. The Communicator interface pops up with the user already selected to send a
message to. See figure 13b.

Figure 13b
To remove an Online Notification Watch from a user:
1. Locate the user in the User Tree. Right click on the user's name.
2. Select "Remove Online Notification Watch" then left click. See figure 13c.

© 2006 - R.B.Zack & Associates, Inc.
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Figure 13c
Note: If you exit Communicator or shut down your computer, all Online Notification Watches will be
removed.

© 2006 - R.B.Zack & Associates, Inc.
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Add To Favorites
The Add To Favorites feature allows you to list recipients in the Favorites section of your User Tree.
This makes locating frequently contacted users quicker and easier.
To add a user to Favorites:
1. Locate the user in the User Tree. Right click on the user's name.
2. Select "Add to Favorites" then left click. See figure 14a.

Figure 14a
3. The user "John Savage" has now been added to the Favorites section of the User Tree.
See figure 14b.

Figure 14b
Note: Users can also be "dragged and dropped" into the Favorites section. Left click on the username,
drag it on top of Favorites then release.
To remove a user from Favorites:
1. Locate the user in Favorites. Right click on the user's name.
2. Select "Remove from Favorites" then left click. See figure 14c.
© 2006 - R.B.Zack & Associates, Inc.
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Figure 14c
Note: This does not delete the user. The user is simply removed from the Favorites section. The user
can still be located within their normal zone.
In addition to users, applications (Communicator, Email, SMSPager), locations (Desk, Home,
etc.), groups and zones can be added to Favorites.
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Groups
The Group feature allows you to create customized lists of recipients.
To create a group:
1. Go to File > Advanced User Tree to display the Proxy Tree. See figure 15a.

Figure 15a
2. Locate "Groups" in the Proxy Tree. Right click on "Groups" then select "New Group".
See figure 15b.

Figure 15b
3. In the Create New Group window, enter a name for the group. Click "OK". See figure 15c.
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Figure 15c
The new group will now appear in the Groups section of your User Tree.
Note: By default, the group type will be "Private". This means that only you will be able to see the
group. Your network administrator may allow you to create "Public" and "Zone Public" groups. These
can be seen by everyone (Public) or everyone within the same zone (Zone Public).
To add a user to a group:
1. Locate the user in the Proxy Tree. Right click on the user's name.
2. Select "Add to Group". If there is more than one group, select the group then left click.
See figure 15d.

Figure 15d
3. Click "Close" (X) on the Proxy window when you are finished adding users.
Important: Do not select Main > "Exit" when attempting to close the Proxy. This will shutdown the
Proxy and you will be disconnected from the IMiN network.
To remove a user from a group:
1. From the Proxy Tree, locate the user inside the group. Right click on the user's name.
2. Select "Remove from this Group" then left click. See figure 15e.
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Figure 15e
In addition to users, applications (Communicator, Email, SMSPager), locations (Desk, Home,
etc.), zones and even other groups can be added to a group.

To delete a group:
1. In the Proxy Tree, locate the group. Right click on the group name.
2. Select "Delete" then left click. See figure 15f.

Figure 15f
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Communicator Preferences

2.15.1 General
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Item

Description

Always on Top

Always leaves the message window in the forefront of the screen.

24 Hour Times

Times are in military form ex: 16:00 = 4:00pm.

Communicator will automatically startup when Windows starts. If
this is not checked, Communicator can be started by going to the
IMiN program group.
Start Minimized
Communicator starts with the Communicator icon in the System
Tray.
Auto Display Sent This feature only works with the tabbed (IM style) skins.
Messages
Normally, a conversation tab is created when a reply is received
from the recipient. When this option is selected, the conversation
tab is created when the message is sent. The sent message is
also displayed.
Auto Minimize
Message window will automatically minimize after a message is
after Sending
sent. This is the opposite behavior of public IM systems that
presume a person will be spending much of their time sending
messages. The default behavior of Communicator is to get out of
your way so you can do other work. If this is unchecked,
Communicator will remain maximized.
Stay in Taskbar on Minimizing Communicator (clicking on Close or Minimize, hitting
Minimize
the Escape key) sends the program to the Taskbar.
Unread Messages If there is more than one unread message, hitting Close or
disable Close
Escape will advance to the next unread message until all
messages are read.
Close Button also By default, clicking the Close button on the Toolbar also clears
Clears
the following areas:
·
Recipient
·
Outgoing message area
·
Incoming message area
Unchecking this will retain the current contents. This only affects
the behavior of the Close button and not the File > Hide option.
Simple World Tree By default, each user is shown once with the option to expand to
Mode
show multiple locations\applications.

Default
ü

Auto Start

Checking this option gives a simplified display of one item per
user\location\application which cannot be expanded.

Reply to All by
Default
Enter Key Sends
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Note: This does not affect the display of the File > Show Proxy
Tree option.
If you receive a message along with other recipients, your reply
will be sent to all of those recipients as well as the sender.
Allows you to send a message by hitting the Enter key rather than
having to click the Send button.

ü

ü

ü

ü
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Message Notification
Item

Description

Default

Auto Maximize on
Receive

Communicator automatically expands when a new message is
received. If you find this behavior too disruptive, unchecking this
will only play a notification sound and cause the Communicator
icon in the System Tray to start flickering to get your attention.
Notify with Balloon The notification of new message is shown with a balloon tip that
Tip
lasts a specified number of seconds.

Auto Advance to
next Message

ü

Automatically advances to your next incoming message in the
window after waiting a specified number of seconds. By default, if
multiple messages are received, you have to take action after the
first message to view the second. If this option is checked, the
second message will automatically appear. The previous can still
be viewed in history. This can be useful if you tend to receive a
lot of messages and don't respond to each one.

In Auto Reply Mode
Note: This area only disables selected forms of notification while you are in AutoReply mode. Items in
this area will not enable a option that is disabled in another area. For example, if sound is disabled for
incoming messages, you cannot turn it on by un-checking the "No Sounds" box. If sound is enabled
for incoming messages, you can disable it while in AutoReply mode by checking the "No Sounds"
box.
Item

Description

No Sounds

By default, you'll hear a sound when you receive a message while
you're in AutoReply mode. If you don't want to be bothered by
that, check this item.
If incoming messages are normally maximized when "Auto
Maximize on Receive" is checked, you can disable it by checking
this box. Uncheck this item if you want to see the text of incoming
messages. If you're not maximizing incoming messages, this box
has no effect.
If "Auto Advance" is checked, it can be disabled by checking this
box. If you're not auto advancing to the next message, this box
has no effect.
If "Notify with Balloon Tip" is checked, the balloon message can
be disable by checking this box. If you're not getting balloon tips,
this box has no effect.

No Maximize

No Auto Advance

No Balloon Tip

Default

ü

ü
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One-touch Maximize
The default setting is shown below. Pressing Ctrl + Shift + up arrow will maximum Communicator.
This can be customized to any key combination you wish. This is identical to doing the following:
·
·

Left-clicking on the Communicator icon in the system tray
Right-clicking on the Communicator icon in the system tray and selecting Show

Key

Value

Ctrl +

ü

Alt +
Shift +

ü

Keystroke

Arrow up

Default Recipient
This controls the assumptions Communicator will make as to who you want to send a new message
to. The None option requires you to always specify the recipient. The other two options both assume a
specific individual.
Item

Description

None

Check this if you always want to select the recipient of each new
message.
Check this if you want the default recipient of each new message
to be the last person you received a message from. This is good
for continuing conversations with the same person.
Check this if you want a specific person to be the default for each
new message. This is useful for people who typically
communicate with a single person, such as their boss. The dropdown list is activated if you check this option.

Last

Fixed

Default

ü

Default Message Format
These settings allow you to change the default text fomat of your outgoing messages.
Item

Description

Bold

Places text in bold.

Italics

Places text in italics.

Underline

Underlines text.

Color

Colors text.
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Not At Desk Mode
Communicator keeps track of activity on your computer. If it senses that you are away from your
desk, it can respond to an incoming message to say that you are away from your desk. Think of this
as an automatic "AutoReply" option.
Note: When AutoReply is turned on, it overrides the Not At Desk mode.
Item

Description

Default

Not At Desk mode If this is checked, the message listed below will be sent as an
automatic response if your mouse & keyboard are inactive for the
specified number of minutes. Note: Manually putting yourself in
AutoReply mode will override this.
Inactivity period
If there is no keyboard activity for this number of minutes, you
(min)
will be considered away from your desk.

ü

15
Max=480
(8 hours)
Min=5
10

Delay before send If the inactivity limit above has been exceeded, the message in
(sec)
the box below will be returned to the sender when a new
message arrives. This controls how quickly your response is sent. Max=60
The delay is to give you an opportunity to respond if you are near Min=1
your desk.
Message
This is the message that will be sent in response to any incoming Sorry…
message.
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2.15.2 Delivery & Status Notifications

User Status Monitoring
Item

Description

Display Status Changes Shows status changes when any Communicator on your
in the Status Bar
network changes status. Example: When a user turns off
AutoReply, the following will be displayed:
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Default
ü
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AutoReply/ Not at Desk Receipt
Item

Description

Default

Ask me whether to
place an automatic
Online Notification
Watch

When you receive an AutoReply or Not At Desk message from
another user, Communicator can automatically place an
Online Notification Watch on the user for you.

ü

When this option is checked, Communicator will display the
following notification asking whether you want to place this watch:

When this option is unchecked, you will not see this notification.

By default, add an
Online Notification
Watch

Note: Checking the "Remember my selection" box has the same
effect as un-checking this option.
This option only has an effect if "Ask me whether to place an
automatic Online Notification Watch" is unchecked. When this is
the case and "By default, add an Online Notification Watch" is
checked, an Online Notification Watch is always automatically
added. If this is unchecked, an Online Notification Watch is never
automatically added.

ü

Online Notifications
If you asked to be notified when a person comes back online, this area determines exactly how you
will be notified. The default settings notify you in the most intrusive manner possible. These can be
modified to something much less intrusive, or removed completely if you are not interested in
receiving notification that someone has come back online.
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Item

Description

Notify with Balloon Tip

This will tell you the person is back online with a balloon tip.

Duration (10 -> 30 sec) If the box above is checked, this setting determines how long
the balloon tip will stay at the bottom of the screen. If the box
below is checked to initiate a reply when you click on the
balloon, you should probably increase this setting to give you
more time to respond.
Balloon click initiates
Clicking on the balloon will pop-up Communicator to initiate a
Reply
reply to the person. If you check this box, you should probably
un-check the "Initiate a Reply" box below. If that box is
checked, Communicator will have already popped up.
Notify with Audio
Notify that the person is back online with the sound defined in
"Watched Entity Online" on the Audio page. Checking only
this option is the least intrusive way of being notified.
Initiate a Reply
Communicator will pop-up on your screen ready to send a
response to the person who just came back online.

41

Default
ü

10

ü

ü

Enable Delivery Reports
The default behavior of Communicator is to display the delivery results of your outgoing messages in
the status area. Normally, after a message is sent, you should see:

If you are sending a message to a number of people, such as everyone in your "Favorites" list, some
of them may not be available. In that case, you see that the delivery was only partially successful.

If the message could not be delivered to any of the recipients, you see that it failed.

Disabling this option will display nothing as to whether your message was delivered or not. The
default "Ready" status will be retained.

Note: It is recommended that you leave this option enabled.
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Item

Description

Default

Notify of Partial Failures A "partial failure" occurs when you send a message to more
than one recipient but some of the recipients do not receive
the message. This option determines whether you are notified
of partial failures. If this is unchecked, you will only be notified
of a failure when no one receives your message. Example of a
partial failure notification using a balloon tip:

Notify with Audio

Notify of delivery failures with the sound specified in
Communicator Preferences > Audio > Message Delivery
Failure.
Notify with Balloon Tip Notify of delivery failures with a balloon tip at the bottom of
the screen.
Duration (10 -> 30 sec) The length of time the balloon tip will display at the bottom of
the screen.
Display Detailed Report Determines whether the delivery report should include the
details of the message destinations.
Only Report Failed
Determines whether the report should only list those
Destinations
destinations that failed. If this is unchecked, successful
destinations will also be listed in the report.
Resolve Unknown
Advanced feature. Leave box unchecked.
Report Destinations

ü

ü
10
ü
ü
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If delivery reports are enabled, they are always stored with each message in your history. This can be
viewed by going into History, double-clicking on a message, then clicking the Delivery Report button.
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2.15.3 Audio

This section allows you to control what sound you hear for various events. By default, sounds are
enabled for all four Communicator events. If you want Communicator to work silently, uncheck all of
the WAV Audio and PC Speaker boxes.
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Item

Description

WAV Audio

Any WAV sound file on your computer can be associated with a
Communicator event.
Sound file location. Communicator is distributed with four sound files.
You can use these or substitute your own.

Browse

PC Speaker
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The Advanced button lets you build a custom tune, note by note. This
can be useful if you do not have speakers on your computer and must
rely on the internal PC speaker. Or, if you've got some time on your
hands and a little musical ability, it just might be fun to create your own
tunes.
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Communicator events are:
Event

Description

First Message Received This is the sound you are most likely to hear – the sound of a new
message.
Subsequent Messages Sometimes you may receive messages from multiple people at about
Received
the same time. If you receive another message before you are able to
respond to the first message, that second message is referred to as a
"subsequent message". You won't see it until you finish with the current
message, but this sound will let you know it's there.
Message Delivery
If Communicator is unable to deliver a message to a recipient, this is
Failure
the sound you'll hear.
Watched Entity Online When an Online Notification Watch is triggered by a user coming back
online, this is the sound that will be played.

Repeat Audio Message Received Notification until all messages are read
Item

Description

Default

Repeat every xx
seconds, xx times...

Sets the interval in seconds and the number of times the
"message received" sound will be repeated until you read the
message or start replying.
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2.15.4 Fast Keys

Fast Keys are user-definable sets of "canned" messages that can be sent with a single keystroke or
mouse click. You can customize the Caption and Response for any Fast Key.
Primary Set
The first set of Fast Keys is known as the Primary Set.

Note: The number of Fast Keys displayed at the bottom of Communicator varies depending on which
skin you are using. Most skins only show the first 12 keys.
Clicking one of these buttons, or hitting function keys F1 through F12 at the top of your keyboard, will
take the text from the Response field and put it into the outgoing message area of Communicator.
The message will then be sent immediately to the recipient.
© 2006 - R.B.Zack & Associates, Inc.
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Checking the Insert Text box...

...allows you to add additional text to the message before sending it.

Control Key Set
An additional set of 12 keys is also available. This is known as the Control Key Set.

These are identical in functionality to the keys in the Primary Set. If your skin does not display these,
hold down on the Ctrl key to display them. Releasing the Ctrl key returns to the Primary Set. If you
want to use any of them, you must do so while holding the Ctrl key down.
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2.15.5 Skins

Skins change the outward appearance of Communicator. In general, the basic functionality is the
same from skin to skin. However with certain skins (i.e. small skins), not all options will be available.
Full Skin
Tabbed DataTel A windows skin with conversation tabs, the user tree
Lite (12)
permanently visible and 12 Fast Keys.
17 full skins are currently available to select from.
Small Skin
Long Win Min

A Min size skin with a windows look that contains 3 full fast keys

3 small skins are currently available to select from.
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You can toggle between full skin mode and small skin mode by using the Alt + G keyboard shortcut.
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2.15.6 Message Display

These settings control the way messages are displayed on your screen. The screenshot above shows
the default settings. The Preview window at the bottom of the screen will show the effect of any
changes you make.
Conversation Auto Close Time
This setting only affects tabbed (IM style) skins. It determines (in minutes) how long a tabbed
conversation stays open. If a particular conversation has had no activity after this period of time, its
tab will automatically close.
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Keyboard Shortcuts
Keyboard shortcuts enable the majority of Communicator functions to be performed quickly by using
a combination of keys. Shortcuts are ideal for advanced users who want to save time or prefer to use
the mouse as little as possible.
Shortcut

Function

Ctrl + Shift + Up Arrow

Maximize Communicator from the system tray or bring it to the
front
Minimize Communicator to the system tray

ESC
F1 to F12 and
Ctrl + F1 to F12
Alt + 1 to Alt + 4

Sends selected Fast Key response as a reply to a message

Alt + A

AutoReply

Alt + C
Alt + F

Clears the recipient, sender, incoming and outgoing message
windows
Find Users

Alt + G

Toggle skin mode

Alt + H

History

Alt + M

Sets the cursor focus to the outgoing message window

Alt + N

Clears and sets the cursor focus to the recipient window

Alt + P

Communicator Preferences (Tools)

Alt + Q

Close current conversation tab.

Alt + S

Send message

Alt + X

Displays EBS Proxy tree

Alt + Right

View next message

Alt + Left

View previous message

Alt + ?

View IMiN Communicator Help

Alt + F4

Close Communicator

Select conversation tab 1 through 4
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Frequently Asked Questions

1. Every time I receive a message, IMiN Communicator pops up on the screen and interrupts
what I'm doing. How can I stop that?
By default, Communicator is set to pop-up when a message is received. To change this, click on the
Tools button. On the General Tab in the Message Notification section, uncheck the "Auto Maximize
on Receive" box.
2. Every time I send a message, the Communicator window disappears. Where does it go and
how do I keep it from disappearing?
By default, the Communicator window is set to minimize to the system tray after sending a message.
To change this, click on the Tools button. On the General Tab in the General section, uncheck the
"Auto Minimize after Sending" box.
3. In a previous version of DataTel, I could send a message to someone when they were offline but IMiN Communicator does not allow this.
Communicator uses email to handle off-line messaging. This is an optional feature. Contact your
network administrator to find out if it available at your organization.
4. The Communicator icon disappeared from the system tray. What can I do to bring it back?
By default, Windows XP hides inactive icons. To change this, right click on an empty area in the
Taskbar then select Properties. On the Taskbar tab in the Notification section, either (a) uncheck the
"Hide inactive icons" box or (b) click the "Customize" button, select IMiN Communicator from the
Current Item list then change the behavior to "Always Show".
5. My computer does not have speakers so I don't hear the audible alert when a new message
arrives.
If your computer does not have speakers, Communicator can use the built-in beeper inside your PC.
Click on the Tools button. On the Audio tab, check the "PC Speaker" box for each audible alert.
6. Can IMiN Communicator send file attachments?
No.
7. I can't bring any other windows to the front when the Communicator window is up. Can I
change this?
Yes. To change this, click on the Tools button. On the General tab in the General section, uncheck
the "Always on Top" box.
8. The icon keeps toggling back and forth between and a single dialog bubble and a double
dialog bubble. What does this mean?
This means you have unread messages. Bring up Communicator and click the message advance
button until all messages have been read.
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